## Content

**Introduction** ......................................................... 1
  - Indications for use .......................... 1
  - Contraindications .......................... 1
  - General warnings and cautions .......... 1

**Equipment** ......................................................... 3
  - Device ........................................ 4

**Assembling the ApneaLink Air system** .................. 5
  - Inserting the batteries .................... 5
  - Putting the device on the belt .......... 6
  - Connecting the accessories to the device 6
  - Fitting the belt ............................ 8
  - Fitting the accessories .................. 9

**Using the ApneaLink Air device** ......................... 13
  - Starting the test .......................... 13
  - Stopping the test - check if test complete 14
  - Disassembly ................................ 15

**Using the ApneaLink software application** ......... 16
  - Starting the program ..................... 16
  - Preparing a recording .................... 16
  - Downloading data from the device .... 18
  - User interface and software features .. 19
  - Database .................................. 23
  - Signal view ................................ 24
  - Report view ................................ 40
  - File transfer ............................... 47

**Cleaning and maintenance** ................................. 53
  - Cleaning .................................. 53
  - Disinfection ............................... 54
  - Maintenance ............................... 54
  - Servicing .................................. 54

**Troubleshooting** ............................................... 55
  - Device .................................... 55
  - Program .................................... 56
  - Analysis ................................... 58

**Technical specifications** .................................. 60
  - System requirements ..................... 60
  - Device, pulse oximeter and effort sensor 60
  - Symbols ................................... 63
  - Disposal ................................... 64

**Limited warranty** ............................................. 65
Introduction

Indications for use

The ApneaLink Air device is indicated for use by Health Care Professionals (HCP), where it may aid in the diagnosis of sleep disordered breathing for adult patients. ApneaLink Air records the following data: patient respiratory nasal airflow, snoring, blood oxygen saturation, pulse, respiratory effort and body position during sleep. The device uses these recordings to produce a report for the HCP that may aid in the diagnosis of sleep disordered breathing or for further clinical investigation. The device is intended for home and hospital use under the direction of a HCP.

Contraindications

• The ApneaLink Air system must not be used in the vicinity of an MRI device.
• Explosive Hazard: Do not use the ApneaLink Air system in an explosive atmosphere or in the presence of flammable anesthetics or gases.

General warnings and cautions

The following are general warnings and cautions. Further specific warnings, cautions and notes appear next to the relevant instruction in the manual.

⚠️ WARNING

A warning alerts you to possible injury.

Do not set up the ApneaLink Air system while it is attached to a personal computer via USB.

⚠️ CAUTION

A caution explains special measures for the safe and effective use of the device.

• The ApneaLink Air should only be used with accessories recommended by ResMed. Connection of other accessories could result in injury, or damage to the device.
• Additional equipment connected to medical electrical equipment must comply with the respective IEC or ISO standards (e.g., IEC 60950 for data processing equipment). Furthermore all configurations shall comply with the requirements for medical electrical systems (see IEC 60601-1 clause 16 of the 3Ed.). Anybody connecting additional equipment to medical electrical equipment configures a medical system and is therefore responsible that the system complies with the requirements for medical electrical systems. Attention is drawn to the fact that local laws take priority over the above mentioned requirements. If in doubt, consult your local representative or the technical service department.
• Depending on their skin condition or general state of health, patients will have different levels of sensitivity to materials used in the ApneaLink Air accessories. If the patient experiences an allergic reaction use of the system should be discontinued.

• Do not use the system if any of the accessories are ripped, broken or bent or if the housing of the ApneaLink Air device is broken.

• Accuracy of automatic analysis for patients with breaths per minute higher than 30 bpm cannot be assured.

• In the US, Federal law restricts this system to sale by or on the order of a physician.

**Note:**

A note advises of special product features.

• Read the entire manual before using the ApneaLink Air system.

• When using consumables and accessories, please read the manufacturer’s information supplied with the products.

• Only use the nasal cannula or disposable oximeter finger sensor from their original packages. If the packaging is damaged, the respective product must not be used, and should be disposed of along with the packaging.

• ApneaLink Air is now supported by AirView™ in some regions. To find out whether this service is available in your region contact your local ResMed Customer service. If the service is available in your region and you require assistance in configuring your ApneaLink software with AirView, please contact your local ResMed Technical Service.
## Equipment

The ApneaLink Air system includes:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ApneaLink Air device</td>
</tr>
<tr>
<td>2</td>
<td>Effort sensor</td>
</tr>
<tr>
<td>3</td>
<td>Belt</td>
</tr>
<tr>
<td>4</td>
<td>Oximeter belt clip*</td>
</tr>
<tr>
<td>5</td>
<td>Oximeter*</td>
</tr>
<tr>
<td>6</td>
<td>Disposable oximeter finger sensor*</td>
</tr>
<tr>
<td>7</td>
<td>Reusable oximeter finger sensor*</td>
</tr>
<tr>
<td>8</td>
<td>Nasal cannula</td>
</tr>
<tr>
<td>9</td>
<td>Bag (not shown)</td>
</tr>
</tbody>
</table>

*This item may only be available as accessory in some countries.

Delivery schedule ApneaLink Air basic set:
- ApneaLink Air device
- Nasal cannula
- Belt
- USB cable
- Installation and driver CD
- 2 luer-lock caps, ventilated for nasal cannula and effort sensor connection
- 2 batteries, 1.5 V
- Carry bag

Delivery schedule ApneaLink Air complete set:
- ApneaLink Air device
- 3 nasal cannulas
- ApneaLink Air oximetry accessories:
  - Nonin Xpod® Oximeter Type 3012 LP
  - Nonin reusable finger pulse sensor Type 8000 SM
  - Clip fastener for Nonin Xpod
- Belt
- USB cable
- Installation and driver CD
- 2 luer-lock caps, ventilated for nasal cannula and effort sensor connection
- 2 batteries, 1.5 V
- Carry bag
- Effort sensor
Delivery schedule for consumables and accessories:

• Westmed ApneaLink Air Cannula (carton with 25 pieces)¹
• Nonin disposable finger pulse sensor, Type 7000A (carton with 24 pieces)¹
• ApneaLink Air accessories for oximetry (Nonin Xpod Oximeter Type 3012 LP²
  for ApneaLink Air, Nonin disposable finger pulse sensor Type 7000A¹, clip
  fastener for Nonin Xpod²)
• Nonin Clip finger pulse sensor for multiple use, Type 8000AA²
• Replacement Effort Sensor²

¹ single use
² multipatient reuse

Device

The ApneaLink Air device has the following lights, connectors and button:

1. Test complete light
2. Nasal cannula connector and accessory light
3. Power button
4. Oximeter connector and accessory light
5. Effort sensor connector and accessory light

The “test complete” light simply shows whether or not the test is done. The ApneaLink Air device considers the test done with the evaluation time of the flow or the flow and oximetry analysis. The evaluation time can be set in the software. A green light shows that the test is done. A red light shows that the test must be repeated. The evaluation time is the recorded time excluding artefacts, signal too small periods, the start of evaluation event (in general first 10 minutes of recording) and the end of evaluation event (in general last 2 minutes). If there are several recordings on the device, the green “test complete” light shows that there is at least one complete recording on the device.
Assembling the ApneaLink Air system

**CAUTION**

- Before assembling the ApneaLink Air system it is important to inspect the condition of the device and all the accessories. If there are any visible defects, the device should not be used.
- When the device is not in use, you should always screw on the ventilated protective caps supplied. Do not use any other caps.
- The nasal cannula and the disposable oximeter finger sensor are intended for single use only, and must be disposed of after use.
- Do not reuse single use sensors to prevent the risk of cross contamination.

**Notes:**

- The physician or healthcare provider is responsible for explaining to the patient the functions of the ApneaLink Air system and how to operate it safely with the help of the Patient Instruction and the Clinical Guide.
- To ensure that recording results are accurate, only equipment recommended for the ApneaLink Air should be used (see “Equipment” on page 3). The equipment must not be modified.
- Use of the pulse oximeter with the oximeter finger sensor is optional. Pulse oximetry measurement results are not included in the risk indicator calculation. These will be shown separately on the report.

Inserting the batteries

The battery compartment is located at the back of the device. Insert the batteries in accordance with the instructions printed inside the device. Insert freshly charged batteries or new batteries into the device before each recording. Use only the specified types of battery or rechargeable battery:

- Two NiMH rechargeable batteries (Micro/AAA/HR03/1.2 V/min. 1000 mAh) or
- Two batteries (Micro/AAA/LR03/1.5 V/min. 1000 mAh).

**Notes:**

- Fresh, fully charged batteries will last approximately 10 hours while recording.
- When the device is not in use, remove the batteries from the device to prevent the possibility of damage from leaking battery fluid.
- Store batteries according to the manufacturer’s specification.
- The batteries in the initial package may be reduced in capacity due to uncertain transport conditions.
Putting the device on the belt

1. Thread one end of the belt through the slots on the back of the device. Check that the device is positioned as shown.

2. Flip the device over. Thread the end of the belt closest to the device through one of the slots on the effort sensor.

3. Fasten the tab to the belt. Slide the device into a position that is close to the effort sensor.

Connecting the accessories to the device

⚠️ CAUTION
The recorder’s pressure sensors are highly sensitive. For this reason, you should never blow directly into the connections for the nasal cannula or the effort sensor.

The accessories may already be attached to the device. If they are not attached, connect them as shown.

Remove the ventilated protective caps from the nasal cannula and effort sensor connections. Keep the protective cap for further use.
Assembling the ApneaLink Air system

Connecting the nasal cannula and the effort sensor

1. Insert the connector end of the nasal cannula into the nasal cannula connector on the device. Turn clockwise until the connector is secure.

2. Insert the connector end of the effort sensor into the effort sensor connector on the device. Turn clockwise until the connector is secure.

Connecting the oximeter

1. Attach the oximeter finger sensor to the oximeter.

2. Attach the belt clip to the oximeter.

3. Attach the oximeter to the oximeter connector on the device by pushing it on.
Fitting the belt

⚠️ CAUTION

• To avoid irritation or allergic reactions, wear the belt and device over a long-sleeved shirt.

• To ensure accurate body position results are recorded, position the device parallel to the spine. See step 2.

Notes:

• The easiest way to put on the device is while standing in front of a mirror.

• For women, the belt should be worn above the breasts.

• Do not overtighten the belt as this would reduce signal quality and reduce patient’s comfort. The belt should be secure and comfortable.

1. Pull the belt around the body. Thread the free end of the belt through the free slot on the effort sensor and fasten the tab to the belt.

2. Check that the belt is secure and comfortable and that the device is positioned over the centre of the chest. Position the device parallel to the spine.

3. If using an oximeter, slide the clip onto the belt. The clip should be worn on the same side of the body as the oximeter finger sensor.

The ApneaLink Air respiratory effort sensor is proprietary ResMed technology using a simple pneumatic technology. The tube inside the effort sensor gets deformed by pulling the belt. This volume change results in a pressure change which gets recorded by the pressure sensor. It has been tested and found comparable in accuracy to RIP technology.
Fitting the accessories

⚠️ CAUTION
If the patient develops redness, irritation or a rash from the nasal cannula or oximeter finger sensor, it might be an allergic reaction. Advise the patient to discontinue use.

Nasal cannula

⚠️ WARNING
Ensure that the cannula is fitted as described so as not to pose a strangulation risk.

1. Insert the prongs into the nostrils. Make sure the curved side is pointing towards the back of the nose.
2. Loop the plastic tubing around the ears.
3. Pull the slider up towards the chin until the plastic tubing is secure and comfortable.

>Note: If the nasal cannula does not stay in the nose, use medical tape or adhesive bandages on the cheeks to hold it in place.
**Oximeter finger sensor**

**WARNING**

- Ensure that the oximeter clip is positioned on the same side of the body as the finger sensor so as not to pose a strangulation risk.
- The pulse oximeter module is designed to determine the percentage of arterial oxygen saturation of functional hemoglobin. Significant levels of dysfunctional hemoglobin, such as methemoglobin, might affect the accuracy of the measurement. Factors that may degrade pulse oximeter performance or affect the accuracy of the measurement include the following: excessive ambient light, excessive motion, electrosurgical interference, blood flow restrictors (arterial catheters, blood pressure cuffs, infusing lines, etc.), moisture in the sensor, improperly applied sensor, incorrect sensor type, poor pulse quality, venous pulsations, anemia or low hemoglobin concentrations, cardiogreen or other intravascular dyes, carboxyhemoglobin, methemoglobin, dysfunctional hemoglobin, artificial nails, fingernail polish, or a sensor not at chest level.
- Loss of monitoring can result if any objects hinder the pulse measurement. Ensure that no blood flow restrictors (e.g., blood pressure cuff) hinder pulse measurements.
- Operation of the oximeter below the minimum amplitude of 0.3% modulation may cause inaccurate results.

**CAUTION**

- The oximeter has motion tolerant software that minimizes the likelihood of motion artifact being misinterpreted as good pulse quality. In some circumstances, however, this device may still interpret motion as good pulse quality. This covers all available outputs (i.e., SpO₂, HR).
- The oximeter sensor may not work on cold extremities due to reduced circulation. Warm or rub the finger to increase circulation, or reposition the sensor.

**Notes:**

- The finger symbol on the adhesive strip shows the position in which the adhesive tape should be attached to the finger.
- This connection is a press-fit (in-out) connection. Do not twist the oximeter cable when connecting to, or disconnecting from, the device.

Attach the oximeter finger sensor to the fourth finger of the right hand using the self-adhesive strip.

The clinical guide covers the NONIN disposable oximeter finger sensor. For other finger sensors, refer to the instructions in the packaging.
Assembling the ApneaLink Air system

Disposable oximeter finger sensor

1. Remove the backing from the sensor.

2. Place the sensor over the fourth finger on the non-dominant hand. Line up the picture of the fingernail on the oximeter finger sensor with the patient’s fingernail.

3. Fold the tabs around the sides of the finger.

4. Fold the top flap under the finger and wrap it around the finger.

5. The sensor should be positioned as shown.

*Note: If the oximeter finger sensor is uncomfortable, you can move it to a different finger or the other hand.*
Reusable oximeter finger sensor

To fit the reusable finger sensor, slip it over the fourth finger on the non-dominant hand as shown.

*Note: If the oximeter finger sensor is uncomfortable, you can move it to a different finger or the other hand.*
Using the ApneaLink Air device

Starting the test

1. Press and hold the power button in the centre of the device for about three seconds or until the light turns on.

2. Check that lights next to the accessories you are using are green. If any of these lights are red and blinking, the accessories are not attached correctly.

**Note:** All indicator lights will dim (but stay lit) approximately 10 minutes after recording begins.
Stopping the test - check if test complete

1. Press the power button for about three seconds.

2. Check that the test complete light is lit and green. This means the test is complete. If the test complete light is red, replace the batteries and repeat the test tomorrow night.

3. Press and hold the power button for about three seconds to turn off the device.

Notes:
• To re-check the test complete light, press the power button until the light turns on (about three seconds), then press the power button again for about three seconds.
• To replace the batteries, open the battery cover on the back of the device and insert two new batteries.
Disassembly

After recording, the patient must do the following:

1. Remove the belt from the body.
2. Remove all the connectors from the device.
3. Screw the protective caps back on the effort sensor and nasal cannula connector.
4. Disconnect the finger sensor from the oximeter.
5. Remove the device from the belt.
6. Throw away the nasal cannula and the disposable finger sensor (see the Equipment section).
7. Place everything else back in the bag and return it to the physician or healthcare provider as requested.

The physician/HCP must do the following:

• Clean device and multiuse sensors.
• Disinfection (if necessary).
Using the ApneaLink software application

Starting the program
After installing the ApneaLink software the first time, a shortcut is created on the desktop. Double-click to run the program.

Preparing a recording
1. Connect the device to the computer.
2. Run the ApneaLink program.
3. In the Quick Start window click **Prepare ApneaLink**. The Patient Information window appears.
4. If the patient’s personal detail is known, complete the patient record card.
   **Note:** If the patient data has already been recorded, you can open a selection list using the Select patient button to show the names of previous patients. Select the patient required to display the patient’s record card.
5. If the patient’s detail is unknown or these are not to be entered initially click **Anonymous Patient**. In this case, the patient’s details must be recorded later when the recording is downloaded from the device.
6. Set the evaluation time for the test complete by clicking the left mouse button and dragging the pointer to either left or right (see also “Default device configuration” on page 17).
7. Click **OK**.
Notes:

• A dialog box will appear to warn you when preparing a device that still contains recorded material. You can use the dialog box to continue customization or download recordings from the device. Recordings that are not downloaded, together with the associated patient data, are deleted by the customization process.

• The physician is responsible to instruct the patient with the patient instructions and to give it to the patient to take home.

• If you are using several devices, we advise you to mark the device with the name of the patient after customization (eg, by attaching an adhesive label to the device sticker to prevent confusion when assigning a recording).

• If the fields Referred by doctor, History and Comments are completed when the recording is prepared, these will only be available in the patient record card if the download is performed on the same computer. The contents of the Comments field will appear on the report.

Default device configuration

In the tools menu you can change the default settings for the test complete.

1. Click on **Tools > Settings > Device configuration**.
2. Set the default value for the recording channels.
3. Set the default value for a sufficient analysis time.

Faulty device status

When a device gets prepared for a recording a faulty device status is indicated by a continuous red light in the patient information dialog. In this situation, it is not possible to customize the device. The following table describes error messages displayed in the software:

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Action</th>
</tr>
</thead>
</table>
| Device not connected       | • Check the USB connection between device and computer.  
                           | • Check that the driver files in the Windows device manager have been correctly installed.  
                           | • Contact ResMed or an authorized ResMed distributor if the problems continue. |
| Battery voltage too low    | Replace the batteries or rechargeable batteries in the device.  
                           | Required battery voltage: at least 2.4 V (2 x 1.2 V). |
| No battery                 | • Check that batteries/rechargeable batteries have been placed in the device.  
                           | • If the device does contain batteries or rechargeable batteries, check correct pole (+/-) alignment. |

Click **Update** once the error has been corrected. The updated device status is then displayed.
Downloading data from the device

1. Plug the USB cable into the mini USB connector on the device and into an available USB port of your computer.
2. Run the ApneaLink program.
3. Click Download ApneaLink.

Notes:
- If the device was not allocated to a patient during customisation, the download procedure is interrupted and a patient record card appears.
- Data transfer and analysis are complete when the report is displayed.
- Each recording needs up to 15 MB free computer hard disk space. Before downloading, ensure there is enough space available. The available space is displayed in the status bar of the ApneaLink program.
- The download procedure may take up to five minutes.
- Recordings shorter than ten seconds are not stored.
- For recordings with less than 60 minutes of valid data, the analysis time is considered too short for performing a reliable screening result. A note is posted on the report: “Attention: Evaluation period too short!” Any data that is captured by the device can be manually scored.
- If there are several recordings on the device, all the recordings are downloaded and analysed, and a report is produced for each. The report for the longest recording is displayed automatically. The other recordings and reports are also available in the database. All recordings that are transferred during a download have the same patient data.
- If the data has been downloaded successfully, both the recording and the patient data in the device are deleted automatically.
User interface and software features

1. **Menu bar with main menus**: The various program functions are located in the separate main menus.
2. **Toolbar**: The functions available in the toolbar depend on which view has been selected.
3. **View windows**: The ApneaLink program displays patient record cards, database, and signal and report views.
4. **Status bar**: Displays status information for an event that has been selected in the signal view, the size of the database and the available hard disk space.
5. **Dialog box**: A dialog box contains various form fields or control items to issue commands to the program.
6. **Buttons**: A button is a control element that you may use to issue a command to the program directly.

### Menu bar and toolbar

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name/description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Prepare device" /></td>
<td><strong>Prepare device</strong>: Patient record card opens. Personal data is saved in the device.</td>
</tr>
<tr>
<td><img src="image" alt="Download device" /></td>
<td><strong>Download device</strong>: Recording is downloaded from the device, analyzed and evaluated, and displayed as a report.</td>
</tr>
<tr>
<td><img src="image" alt="Back" /></td>
<td><strong>Back</strong>: Switches to the previous view.</td>
</tr>
<tr>
<td><img src="image" alt="Forward" /></td>
<td><strong>Forward</strong>: Switches to the last selected view.</td>
</tr>
</tbody>
</table>
| ![Screenshot](image) | **Screenshot**: A screenshot of the recently displayed signal view on the monitor is made and attached to the most recent report. The report and the screenshot are shown as a preview in a dialog box.  
  **Note**: This feature is only available in signal view. |
File menu

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name/description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📘</td>
<td><strong>Database</strong>: Opens the database. Patient details, recordings, and reports are managed in the database. Patient record cards, recordings, and reports may be opened or deleted.</td>
</tr>
<tr>
<td>📜</td>
<td><strong>Archive</strong>: Opens the archive dialog box with the archived records. Selected recordings can be marked for archiving with media type, media name, and a target directory.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Save report locally</strong>: Saves the selected report as a PDF file in the database.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Print report</strong>: Prints the selected report.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Print Patient Instructions</strong>: Prints the Patient Instructions.</td>
</tr>
<tr>
<td></td>
<td>- <strong>View external data</strong>: Opens recordings that are not available in the database.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Duplicate</strong>: Creates a copy of a recording in a freely selectable target directory.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Export</strong>: The selected recording can be exported as EDF, EDF+ or CSV (statistics database) file.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Import recording</strong>: OSA file can be selected from the file system and imported into the database.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Send report by email</strong>: Selected report is attached as a PDF file to an email.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Send recording by email</strong>: Selected recording is attached as an OSA file to an email.</td>
</tr>
<tr>
<td>📦</td>
<td><strong>Save locally</strong>: Saves externally available files or archived recordings as copies in the database.</td>
</tr>
<tr>
<td>✒</td>
<td><strong>Exit</strong>: Ends the program. The application is closed.</td>
</tr>
</tbody>
</table>

Edit menu

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>This function is available only in signal view when editing events. This function can be used only to reverse the last action carried out.</td>
</tr>
</tbody>
</table>
View menu

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name/description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Patient record card" /></td>
<td>Patient record card: Opens the patient’s record card selected in the database. Personal details and information on the patient are recorded on the patient record card.</td>
</tr>
<tr>
<td><img src="image" alt="Report view" /></td>
<td>Report view: Opens the report selected in the database. The report contains the analysis of the recording.</td>
</tr>
<tr>
<td><img src="image" alt="Signal view" /></td>
<td>Signal view: Opens the recording selected in the database. The signal view displays the recording signal curves together with the events.</td>
</tr>
<tr>
<td><img src="image" alt="Event list" /></td>
<td>Event list: Opens the event list in the signal view. The event list lists all events sorted by event type with precise time details.</td>
</tr>
<tr>
<td><img src="image" alt="Quick start" /></td>
<td>Quick start: Opens the quick start menu.</td>
</tr>
</tbody>
</table>

Tools menu

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Re-analyze</td>
<td>Repeats the analysis of a recording based on the set analysis parameters. Modifying the report, the patient record or the records (waveform data): any time a software operator changes anything on any of these three records the “Reanalyze” button must be pressed before those changes or additions will be stored or appear on those records.</td>
</tr>
<tr>
<td>New event group</td>
<td>Creates a new event group in the event tree panel of the event list. A dialog box appears for naming the event group and assigning the event types to the event group.</td>
</tr>
<tr>
<td>Delete event group</td>
<td>Deletes the event group selected in the event list.</td>
</tr>
<tr>
<td>Edit event group</td>
<td>Opens a dialog box for a selected event group to allocate event types.</td>
</tr>
<tr>
<td>Language selection settings</td>
<td>Opens the language selection dialog box. Program interface texts are displayed in the selected language.</td>
</tr>
<tr>
<td>Signal window settings</td>
<td>Opens the dialog box to customize the signal window in the signal view. The signal view is divided into an upper and lower window. Time ranges for the signal view, the channels to be displayed, and events as required for individual device types may be set separately for each window.</td>
</tr>
</tbody>
</table>
### Report settings
- Change the report view size.
- Set the measurement system. The measurement details are displayed in the patient record card and in the report.
- Insert a logo as a bitmap or JPEG graphic into the report via a separate dialog box.
- Specify the number of report copies that can be printed out.
- Enter the name of the physician to whom the patient is to be referred. If a physician has already been entered in the patient record card, the physician's data is displayed. Selected physician data can also be deleted.
- Under extended settings, you also have the option of displaying the indicator graphic with (RI) or without (AHI) flow limitations.

### Analysis parameter settings
Analysis parameters are specifications for analysing the recording. The default parameters set by ResMed may be applied, or individually modified parameters may be set. Modified parameters can be reset to the default values.

### EDF export settings
Opens the dialog box to choose channels and events for EDF export.

### Device configuration settings
Opens the dialog box to set the test complete. The default values can be set for the flow or the flow and oximetry channel and the recording time.

### Send Event Log by email
When an error occurs, the Event log can be sent to ApneaLink Air support.

### Database transfer
Starts the database transfer tool.

## Help menu
### Name Description

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clinical guide</td>
<td>The clinical guide is opened as a PDF file using the Acrobat Reader, if this has been installed on the computer.</td>
</tr>
<tr>
<td>Patient instructions</td>
<td>The patient instructions is opened as a PDF file using the Acrobat Reader, if this has been installed on the computer.</td>
</tr>
<tr>
<td>Program info</td>
<td>Displays systems information on the current program version and also ResMed addresses.</td>
</tr>
<tr>
<td>Recording info</td>
<td>Opens a dialog box that contains detailed technical information on a recording and the ApneaLink Air device selected in the database. This information is particularly relevant for service cases.</td>
</tr>
<tr>
<td>Device Info</td>
<td>Opens a dialog box with information about the usage of the devices.</td>
</tr>
</tbody>
</table>
Database

In the database patient details, recordings (analyses), and reports can be opened in different views or deleted.

To open the database
- Click **Database** on the toolbar.
- Or
- Click **Database** in the **File** menu.

In the database view you have the following options:
- Click once on a file to show related files.
- Double-click on a file to open it in the according view.
- To delete a file, click on it once, then click the delete button.
- To delete several files hold down the control key, click on the files and click the delete button.

**Notes:**
- If you delete a patient’s data, the associated recordings and reports are also deleted.
- If you delete recordings, the associated reports are also deleted.
Signal view
The signal view shows the recording signals as curves together with the events that have occurred.

To open the signal view:
1. Click on the toolbar to open the database.
2. Select a recording.
3. On the toolbar click Signal view.

Note: Signal view must be checked for correctness if the results are used to assist in diagnosis.
Editing events

Inserting events

1. Move the cursor to a channel at the start of the event to be inserted.
2. Click the left mouse button and drag the cursor to either right or left at the end of the event to be inserted.
   A context menu appears showing a list of the event types.

3. Click the desired event type.
   If you insert or edit an event, this results in changes to the report for the recording being analysed. A dialog box appears to confirm if a new report should be created or the current one amended.

Notes:

- Overlapping events are excluded when medically not sensible.
- Depending on device type, not all event types may be available.
- Analysis exclusion times that are manually added to the Saturation or Pulse channel are taken into consideration only when calculating the ODI; these will not otherwise appear in the report result.
- Analysis exclusion times are calculated when determining the evaluation period for the analysis.
- If a recording has been manually post-edited, this is displayed in the database, in the Report table under “Manual status.”

Defining event duration

You can change the event duration from the signal view. Move the cursor to the beginning or end of an event until the cursor shape changes. Drag the column boundary to the desired position.

Allocating an event type

Events are automatically assigned to appropriate event types. You can change this allocation by right-clicking the event to open the context menu for allocation of the event type.
Deleting events

1. Click the event to be deleted in the signal view.
2. Press Delete on the keyboard.

OR

1. On the signal view toolbar click Event list.
2. In the event list, select the event to be deleted.
3. Press Delete on the keyboard.

Notes:

• If an event is deleted inadvertently, restore it using the Undo function in the Edit menu. If several events are deleted, only the last deleted event can be restored.
• If you wish to delete several events in the event list, hold down the Ctrl key and click the events to be deleted.
• If you insert or edit an event, this results in changes in the current report for the recording being analyzed. A dialog box appears to confirm if a new report should be created or the current one amended.

The following table shows a list of all default event types automatically detected by the ApneaLink program and displayed in the signal curves:

<table>
<thead>
<tr>
<th>Event type</th>
<th>Abbreviation</th>
<th>Channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unclassified apnea</td>
<td>UA</td>
<td>Flow</td>
</tr>
<tr>
<td>Obstructive apnea</td>
<td>OA</td>
<td>Flow</td>
</tr>
<tr>
<td>Mixed apnea</td>
<td>MA</td>
<td>Flow</td>
</tr>
<tr>
<td>Central apnea</td>
<td>CA</td>
<td>Flow</td>
</tr>
<tr>
<td>Hypopnea</td>
<td>H</td>
<td>Flow</td>
</tr>
<tr>
<td>Flow limitation</td>
<td>FL</td>
<td>Flow</td>
</tr>
<tr>
<td>Snoring</td>
<td>Sn</td>
<td>Snoring</td>
</tr>
<tr>
<td>Inspiratory flow</td>
<td>If</td>
<td>Flow</td>
</tr>
<tr>
<td>Flow limitation and snoring</td>
<td>FS</td>
<td>Flow</td>
</tr>
<tr>
<td>Baseline saturation</td>
<td>Bs¹</td>
<td>Saturation</td>
</tr>
<tr>
<td>Desaturation</td>
<td>Ds¹</td>
<td>Saturation</td>
</tr>
<tr>
<td>Invalid data</td>
<td>ID</td>
<td>Flow, battery, snoring, saturation, pulse</td>
</tr>
<tr>
<td>Start of evaluation</td>
<td>S</td>
<td>Flow, effort, snoring, saturation, pulse</td>
</tr>
<tr>
<td>End of evaluation</td>
<td>E</td>
<td>Flow, effort, snoring</td>
</tr>
<tr>
<td>Exclusion from analysis</td>
<td>Ae</td>
<td>Flow, effort, battery, snoring, saturation</td>
</tr>
<tr>
<td>Missing oximeter finger sensor/XPod</td>
<td>Ms¹</td>
<td>Saturation, pulse</td>
</tr>
<tr>
<td>Signal too small</td>
<td>Sts</td>
<td>Flow, effort</td>
</tr>
<tr>
<td>Cheyne-Stokes</td>
<td>CSR</td>
<td>Flow</td>
</tr>
</tbody>
</table>

¹ Only for recordings with pulse oximetry
Notes:

- Invalid data can be a result of the incorrect application of the sensors, an inadequate power supply or when a recording is continued within 15 minutes after it has been stopped.
- Event overlaps are checked both during automatic analysis and when events are processed manually. Event overlaps are corrected.
- The first ten minutes of a recording are excluded for analysis and are marked as Start of evaluation event.
- The last two minutes of a recording are excluded for analysis and are marked as End of evaluation event.
Displaying event list

The event list shows all events for the recording that is currently open. When working with the signal view, the event list helps in analyzing a recording by selecting and displaying specific events quickly. The event list consists of event groups and events that have been analyzed in the recording.

1. Open a recording in the signal view.
2. On the toolbar click Event list.

3. To open all events allocated to an event group, click an event group in the Event tree panel.
4. To display an event in the signal view, click an event in the Event list panel.

**Note:** You can hide the event panels by clicking Event list from the toolbar.
Editing event groups

To create an event group:
1. On the Tools menu, click New event group.
2. Select the checkbox next to an event to allocate the event type to the new event group.
3. Click OK.

To edit an event group:
1. In the Event tree panel select the event group to be edited.
2. In the Tools menu click Edit event group.
3. Edit the name in the Event group text field.
4. Click OK.

To delete an event group:
1. In the Event tree panel select the event group to be deleted.
2. In the Tools menu click Delete event group.

To close the event list:
• On the toolbar click Event list .
• On the top right of event list panel click Close .

Settings

Signal view
You can change the default settings for resolution and the channels and events to be displayed separately for the upper and lower window in the signal view.
In the Tools menu, select Settings and then click Signal view.
RESOLUTION
The drop-down lists contain various time ranges that you can set to display the recording. A recording can be displayed for a time range of one second up to a whole night.

CHANNELS
Channels displayed in the signal view can be set and signal curve color can be changed using the Channels function.

1. Click **Channels** to open the Channel setup dialog box.

![Channel setup dialog box]

2. Select one of the following commands as required.

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select all</td>
<td>Selects all channels.</td>
</tr>
<tr>
<td>Enable channels</td>
<td>Activates the selected channel.</td>
</tr>
<tr>
<td>Disable channels</td>
<td>Deactivates the selected channel.</td>
</tr>
<tr>
<td>Assign color</td>
<td>Opens a color selection and assigns the selected color to the highlighted signal.</td>
</tr>
<tr>
<td>Define order</td>
<td>Moves the selected channel upwards or downwards in the required order.</td>
</tr>
<tr>
<td>Channel height ratio</td>
<td>Displays the selected channel larger than the default size of the other channels displayed, by a given factor.</td>
</tr>
<tr>
<td>Standard values</td>
<td>Resets the channel settings to the default values.</td>
</tr>
</tbody>
</table>

3. Click **OK** to apply selected settings.
**EVENTS**

Events are shown in color in the signal view and are assigned to a fixed channel. You can use the Events function to define the color of an event. The dialog box distinguishes between standard events and advanced events. Standard events are taken into consideration when determining the risk indicator and the ODI. The advanced events are regarded as analysis exclusion times. You can also choose whether the event type should be displayed.

1. Click **Events** to open the Event setup dialog box.

![](image)

2. Select one of the following commands as required.

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select all</td>
<td>Selects all events.</td>
</tr>
<tr>
<td>Enable events</td>
<td>Activates the selected events.</td>
</tr>
<tr>
<td>Disable events</td>
<td>Deactivates the selected events.</td>
</tr>
<tr>
<td>Assign color</td>
<td>Opens a color selection and assigns the selected color to the highlighted event.</td>
</tr>
<tr>
<td>Standard values</td>
<td>Re-sets the event settings to the default values.</td>
</tr>
</tbody>
</table>

3. Click **OK** to apply settings.

**SIGNAL CURSOR**

The signal cursor (reticle) is an aid to analyzing the signal curves. You can use it to precisely mark a point along the signal curve. The chronological position and amplitude deflection are displayed in the status line on the lower screen border. To make it appear in signal view, select the Signal cursor checkbox.

**HIDE CHANNELS WITH NO DATA**

You can hide channels that contain no recording data in the signal view. It is particularly useful if a recording has been made without pulse oximetry. To activate this option, select the Hide channels with no data checkbox.
**Analysis parameters**

Analysis parameters are specifications for analyzing the recording. The default parameters set by ResMed may be applied, or individually modified parameters may be set. Modified parameters can be reset to the default values.

To open the settings dialog box for the analysis parameter select **Settings** in the **Tools** menu.

**APNEA**

Apnea is a reduction of airflow to 0–20% that lasts 10 seconds or longer. Using an average of the last five breath cycles (combined inspiratory and expiratory waveforms totaling 10 peaks) the software looks for a reduction of 80% or more from that average to score an apnea event. To end the apnea the average inspiratory/expiratory waveforms must increase within 10 to 80 seconds by 80% (or the user set value) to end the event.

If an apnea is overlapped during 80-100% of its time by an interruption of respiratory drive, then the apnea is scored as central.

If an apnea is overlapped during 20-60% of its time at the beginning by an interruption of respiratory drive, then the apnea is scored as mixed.

If an apnea is not overlapped by an interruption of respiratory drive for up to 20% of its time, then the apnea is scored as obstructive.

---

The following table explains the apnea settings in the analysis parameter dialog box:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apnea threshold in percent</td>
<td>The apnea threshold is reached when the airflow amplitude falls to the currently set value or below.</td>
</tr>
<tr>
<td>Default setting: 20%</td>
<td>Minimum apnea duration in seconds</td>
</tr>
<tr>
<td>Range: 1–90%</td>
<td>Minimum duration of an apnea, during which the airflow amplitude must be below the apnea threshold.</td>
</tr>
<tr>
<td>Range: 10 s</td>
<td>Maximum apnea duration in seconds</td>
</tr>
<tr>
<td>Default setting: 80 s</td>
<td>This value indicates the maximum duration for an apnea. Values above this are not considered apneas.</td>
</tr>
<tr>
<td>Range: 1–100 s</td>
<td>Time threshold for central apnea</td>
</tr>
<tr>
<td>Default setting: 60%</td>
<td>If there is no significant respiratory drive for more than the selected value of the time with reduced flow, the event will be classified as central event (eg, &gt;60%).</td>
</tr>
<tr>
<td>Range: 50%–80%</td>
<td>Effort threshold for central apnea</td>
</tr>
<tr>
<td>Default setting: 8%</td>
<td>If the amplitude of the effort signal is less than the selected value, the criteria for scoring central events is met.</td>
</tr>
<tr>
<td>Range: 2%–30%</td>
<td>Time threshold for obstructive apnea</td>
</tr>
<tr>
<td>Default setting: 20%</td>
<td>If there is no significant respiratory drive for less than the selected value of the time with reduced flow, the event will be classified as obstructive event (eg, &lt;20%).</td>
</tr>
<tr>
<td>Range: 0%–49%</td>
<td>The following schematic figures are examples for the different apnea classes:</td>
</tr>
</tbody>
</table>

**Note:** Apnea differentiation only is available if the effort signal has been recorded. If none or insufficient effort information is available ApneaLink Air scores corresponding apneas as unclassified apneas.
A hypopnea is a reduction of airflow that lasts 10 seconds or longer\(^1\).

ApneaLink Air may identify a hypopnea in the recording according to one of the following criteria:

- If no oximetry data is available, or is missing for a significant portion of the recording, hypopneas are scored when there is a reduction in airflow of 50% that lasts longer than 10 seconds (classic ApneaLink Air definition).
- If the oximetry channel is present and has satisfying quality over the entire recording time, hypopneas are scored when a flow reduction of at least 30% that lasts 10 seconds or longer is detected with a corresponding desaturation event of at least a 4% drop (definition as per AASM – American Academy of Sleep Medicine). The desaturation has to start at the latest 10 seconds after the hypopnea finished.

As the scoring criteria may vary depending on the signal quality of the individual recording, the criteria used is documented in the ApneaLink Air report.

The following table explains the hypopnea settings in the analysis parameter dialog box:

<table>
<thead>
<tr>
<th>Hypopnea threshold in percent</th>
<th>The hypopnea threshold is reached when the airflow amplitude falls to the currently set value or below.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard: 50% (classic definition); 70% (AASM definition)</td>
<td></td>
</tr>
<tr>
<td>Range: 1–90%</td>
<td></td>
</tr>
</tbody>
</table>

Threshold for \(\text{SpO}_2\) signal quality: If the oximetry channel shows a longer proportion of error data than the set percentage during the analysis period, the entire recording will be scored based on flow only (classic definition). The user will be provided with a pop-up dialog box if this occurs.

---

Using the ApneaLink software application

Snoring is an acoustic phenomenon that occurs during sleep when the upper airway becomes partially obstructed and starts to vibrate. The frequency and noise level depend on the type and consistency of the vibrating airway passage, as well as the degree of obstruction and change in breathing behavior.

ApneaLink Air derives the snoring signal from the sensing device and filters the signal to allow a 0-60 Hz waveform to be analysed as snoring. Unlike flow channel data, snoring channel and snoring waveform data is not excluded from reporting based on signal size. All snoring data that meets the user-set parameters for snoring is included.
The following table explains the snoring settings in the analysis parameter dialog box:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Threshold for snoring in percent</strong></td>
<td>Indicates the minimum amplitude threshold necessary for the event to be classified as snoring.</td>
</tr>
<tr>
<td>Default setting: 6 %</td>
<td></td>
</tr>
<tr>
<td>Range: 1.5–10 %</td>
<td></td>
</tr>
<tr>
<td><strong>Min. length of a snoring event in seconds</strong></td>
<td>Minimum duration of noise when breathing in for it to be classified as a snoring event.</td>
</tr>
<tr>
<td>Default setting: 0.3 s</td>
<td></td>
</tr>
<tr>
<td>Range: 0.3–0.9 s</td>
<td></td>
</tr>
<tr>
<td><strong>Max. length of a snoring event in seconds</strong></td>
<td>Maximum duration of noise when breathing in for it to be classified as a snoring event. Noises that last longer are classified as interference noise.</td>
</tr>
<tr>
<td>Default setting: 3.5 s</td>
<td></td>
</tr>
<tr>
<td>Range: 2.0–5.0 s</td>
<td></td>
</tr>
<tr>
<td><strong>Maximum respiratory snoring mean time in seconds</strong></td>
<td>If the mean time between snoring events is shorter than the preset snoring mean time, the adjacent events are then combined to yield one snoring event. The maximum permissible duration of a snoring event is taken into account when combining several snoring events. If the maximum duration of a snoring event is exceeded, all subsequent snoring events (and the mean times between them) are evaluated again in accordance with the currently set analysis parameters. Setting to 0.0 seconds completely switches off the snoring event combination.</td>
</tr>
<tr>
<td>Default setting: 0.5 s</td>
<td></td>
</tr>
<tr>
<td>Range: 0.0–2.0 s</td>
<td></td>
</tr>
</tbody>
</table>

**OXYGEN DESATURATION**

![Image of software interface for analyzing oxygen desaturation settings]
The following table explains the desaturation setting in the analysis parameter dialog box:

<table>
<thead>
<tr>
<th>Threshold for oxygen desaturation</th>
<th>If the saturation level decreases by 4%, e.g., from 97% to 93% or less, a desaturation event is entered in the signal view. It has to last at least 5 seconds and may not be longer than 150 seconds.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default setting: 4 %</td>
<td></td>
</tr>
<tr>
<td>Range: 3–5 %</td>
<td></td>
</tr>
</tbody>
</table>

Note: Saturation values below 70% are less accurate. Values in this range are detected by the oximetry algorithm.

Cheyne-Stokes breathing

Cheyne-Stokes respiration (CSR) is a form of sleep-disordered breathing characterized by a periodic waxing and waning of respiration. The waxing periods (hyperpneas, typically 40 seconds in length) can include large gasping breaths that tend to arouse the patient while the waning periods (hypopneas or apneas, typically 20 seconds in length) cause blood oxygen desaturations.

Briefly, the screening algorithm can be described by the following steps: 1) break the recording into a number of equal length time periods of 30 minutes each with an overlap of 15 minutes of the following epoch, 2) apply signal processing to the time periods, 3) discover waxing and waning periods within the time periods, 4) calculate several features (numbers) from the time periods, 5) compare these features with those from a large database of previously diagnosed patients, and 6) report the likelihood (probability) that the time period contains a CSR pattern.

Thus, the algorithm allows the discovery of the “strength” of likelihood that a CSR pattern has been found and the time of night that it occurred. The likelihood ranges from zero (no likelihood) to one (strong likelihood).

The following table explains the Cheyne-Stokes breathing setting in the analysis parameter dialog box:

<table>
<thead>
<tr>
<th>Threshold for Cheyne-Stokes Breathing</th>
<th>Indicates the minimum value for the analysis of a CSR probability.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default setting: 0.5</td>
<td></td>
</tr>
<tr>
<td>Range: 0.2–0.8</td>
<td></td>
</tr>
</tbody>
</table>
The following is an example of a Cheyne-Stokes breathing pattern:

**FLOW LIMITATION**

The form of the breathing flow curve is crucial in the detection of the flow limitation. During inspiration, the breathing flow increases. After an amplitude peak is reached, the breathing curve flattens out until expiration begins. In order to make a comparison between normal and flow-limited breathing, the two curves are superimposed. The area between the peak of the normal breathing flow and the flattened breathing curve of the flow-limited breathing indicates the missing breathing volume.

To detect flow limitations, the ApneaLink algorithm compares the form of each detected breath with a library (approximately 20 different profiles) of flow limited breathing waveform profiles. The algorithm does an inspiration by inspiration comparison to those waveform profiles.

ApneaLink counts the total number of flow limited breaths in the recording, then calculates the percentage of flow limited breathing to the total breaths detected. It then divides that percentage by 10. That number is the estimated value that is added to the scored AH1 and becomes the adjusted RI (Risk Indicator), eg, 50% flow limited breath adds a value of about five to the Risk Indicator value.

---

Flow limitations which overlap for at least 50% with snoring are classified as flow limitation with snoring events. Flow limitation with snoring is weighted slightly higher compared to a flow limitation without snoring. (Weighting factor for flow limitations with snoring is 1.2 and without snoring is 0.8).

Flow limitation and flow limitation with snoring are calculated and are used to adjust the RI (Risk Indicator) using slightly different weighted factors.

ApneaLink Air does not detect RERAS (respiratory effort related arousals) and UARS (upper airway resistance syndrome), but patients suffering from them show a high percentage of flow limited breathing patterns that will be detected by the ApneaLink software.

**Notes:**
- The flow limitation event is not an adjustable analysis parameter.
- Flow limitation display is switched off by default for U.S.

**Signal too small**
The ApneaLink software marks areas too small for reliable analysis in the flow and effort channel as signal too small.

In the flow channel the ApneaLink software reports a “signal too small” (STS) event when the average signal amplitude during inspiration of 8% of the full scale or less is detected for a time period of at least two minutes.

The STS period continues until the average flow amplitude of at least five breath cycles exceed the 8% threshold mentioned above.

In the case of zero flow detection, the STS period terminates directly when breathing with sufficient amplitude is recognized again.

In the effort channel “Signal too small (effort)” events are detected when the average of 10 maxima and minima falls below a threshold of 1% of full scale and are longer than the maximum length of an apnea event.

**Note:** The signal too small events do not have adjustable analysis parameters.

**Making screenshots of the signal view for a report**

1. Open a recording in the signal view.
2. On the toolbar click **Make screenshot**.
   The Screenshot photo for report dialog box appears showing the most recent report with added screenshots of the current signal view and the event summary of the signal period.
3. Click **OK**.
   The amended report is saved in the database with a new date.

**Notes:**
- To delete a screenshot before saving click **Remove screenshot**.
- You can add a maximum of 10 screenshots to a report.
- Adding screenshots can increase the file size of the report.
Report view

ApneaLink Air reports are generated as PDF files and are displayed in a separate PDF window with its own toolbar. For more information about this application please read the instruction manual for Acrobat Reader.

To open a report double-click on the report in the database.

Report contents

Report Date
The date when the record was downloaded. Each time the report is changed, the date of the last change is stored.

Treating Physician
The name of the treating physician is entered onto the patient record card during the customization process.

Referred To
Details of the physician recommended by the treating physician for further treatment. As an option, you may enter this information in a text field in the Tools menu under Report Settings. The entry is applied to all subsequent reports.

Patient Details
The patient details are copied from the patient record card.

Recording Data
Information containing the date, beginning, end, and duration of the recording. The evaluation period is always at least 10 minutes shorter than recording time since the first 10 minutes of the recording is automatically excluded from the evaluation period.

Analysis Data
This section contains information on evaluating the recording in terms of its beginning, end, and duration. To account for the delay associated with the patient falling asleep, the program starts the evaluation 10 minutes after the start of recording. The end of the evaluation corresponds to the end of the recording. The start and end of the analysis can, however, be set as required in the signal view.

Note: Analysis exclusion times are deducted when calculating the evaluation period.

AHI/RI Indicator Graphic
The main information of the report is displayed in the indicator graphic. The normal range is to the left of the threshold value, marked by a black line. The range indicating a suspected pathological breathing disorder is to the right of this line.

The position of the pointer shows the result for the indicator. If the indicator has reached or exceeded the limit, it is assumed that the patient has sleep disordered breathing (SDB).
AHI and RI values differ by the score for flow limitations found. The indicator graphic is driven by the AHI value or the RI value depending on your settings. 

**Note:** Selecting the “Use AHI” option (see “Report settings” on page 45) alters the calculation of the indicator. In this case, the indicator displays the same as the AHI point score.

**Analysis indices**

**AHI (apnea-hypopnea index):** Mean number of all apnea classes (unclassified, central, mixed, obstructive) and hypopneas per hour in the evaluation period. Events are also shown individually in the apnea and hypopnea index fields. If the measured value exceeds the normal range, the value will be displayed “framed”.

**RI (risk indicator):**
The risk indicator (RI) is calculated as follows:
RI = point score as a sum of AHI + score of FL/FS
Points calculated from AHI:
AHI $\times$ 1 h = number of points (eg, AHI $= 5/h \times 1$ h $= 5$ points)
where h is the evaluation period
FL/FS point score:
Number of points $= 10 \times (0.8 \times FL + 1.2 \times FS) / If$
where:
- AHI = apnea-hypopnea index
- FL = number of flow-limited breaths without snoring
- FS = number of flow-limited breaths with snoring
- If = total number of breaths

If the measured value exceeds the normal range, the value is displayed “framed”.

**% Flow limited breaths without Sn (FL):** Percentage of all flow-limited breaths without snoring in relation to the total sum of all breaths.

**% Flow limited breaths with Sn (FS):** Percentage of all flow-limited breaths with snoring in relation to the total sum of all breaths. An FS is evaluated only if there is a simultaneous snoring event that exceeds 30% of the flow limit duration.

The following details are contained in the report if pulse oximetry has been performed.

**SpO₂ evaluation period:** The SpO₂ evaluation period is the recorded saturation time excluding artefacts, sensor failure and the first ten minutes of the recording marked by the Start of evaluation saturation event.

**ODI (Oxygen Desaturation Index):** This is a mean value that shows the number of desaturations within the SpO₂ evaluation period. If the measured value exceeds the normal range, the value will be displayed “framed”.

**Average saturation:** This is calculated from the measurements of saturation within the evaluation period starting from the tenth minute.
**Lowest desaturation**: Shows the lowest saturation value within all desaturation events.

**Lowest saturation**: Shows the lowest saturation value of the entire recording.

**Baseline saturation**: This value is calculated at the start of a recording, within the first 20 minutes. This is a maximum saturation value that remains stable for at least ten seconds within a range of deviation of +/- 1%.

**Pulse**: The minimum and maximum pulse values are determined throughout the entire evaluation period. The mean pulse value is calculated from all measurement values.

**Proportion of probable Cheyne-Stokes epochs**: This value is the result of the division of all summed-up epochs above the threshold and the total number of epochs.

If an epoch from the analysed recording period is above the defined threshold for the detection of Cheyne-Stokes respiration, this information is shown as well.

**Note**: With the Cheyne-Stokes analysis the whole recording is divided in periods (epochs) of 30 minutes each. The 15 minutes overlap indicates, that the following epoch starts 15 minutes after the beginning of the foregoing epoch.

**Normal**

This column contains values that may be considered normal for a healthy person based on current scientific knowledge. The values enable a comparison to be made with breathing analysis results and the indices calculated from them.

**Result**

This column shows the totals for individual analysis results that were used in calculating the analysis indices.

**Breaths**: these are only breaths in the Evaluation Period, not the entire recording.

**Snoring Events**: snoring events are events for the entire recording and not just for the evaluation period. Snoring data is not excluded as “Signal to small”.

**Analysis status**

The analysis status shows whether a recording was analysed automatically or was manually post-edited.

If no oximetry data is available, or is missing for a significant portion of the recording, this dialog box indicates that the automatic hypopnea analysis is based on flow only (classic ApneaLink Air definition).
## Analysis parameters used

This section contains a brief summary of details on the analysis parameters that were set (see also “Analysis parameters” on page 32).

### Apnea [20 %, 10 s, 80 s, 1.0 s, 20 %, 60 %, 8 %]

- Amplitude threshold for central apnea
- Time threshold for central apnea
- Time threshold for obstructive apnea
- Maximum respiratory mean time when linking apneas/hypopneas
- Maximum duration
- Minimum duration
- Apnea threshold

### Hypopnea [70 %, 10 s, 100 s, 1.0 s]

- Maximum respiratory mean time when linking apneas/hypopneas
- Maximum duration
- Minimum duration
- Hypopnea threshold

### Snoring [6.0 %, 0.3 s, 3.5 s, 0.5 s]

- Maximum resp. snoring mean time
- Maximum duration of a snoring event
- Minimum length of a snoring event
- Threshold for snoring

### Desaturation [4.0 %]

- Threshold for oxygen desaturation

### CSR [0.5]

- Threshold for detection of Cheyne-Stokes breathing
**Graphs**
The extended report contains the following graphs:
- respiratory events
- epochs with identified Cheyne-Stokes breathing
- pulse oximetry signals for pulse and saturation.
In case of bad signal quality in the SpO$_2$/pulse channel (e.g., dislocated oximeter finger sensor) the corresponding recording time is marked as a red bar on top of the signal curve.

**Diagnosis**
This section shows the diagnosis that was entered in the Diagnosis text editor. Comment contents entered during the preparation of the device will be automatically copied to the report.

*Note: If the fields “Referred by doctor”, “History” and “Comments” are completed when the recording is prepared, these will only be available in the patient card if the download is performed on the same computer.*

**Adding comments**
You can add comments to a current report in a text editor that can be opened in the report view.

1. To open the text editor click **Edit comments** on the toolbar.
2. Enter the comment and click **OK**.

*Note: If there are several reports for a single recording, you can only insert comments for the most recent report.*

**Saving a report locally**
Reports are managed within the database. If required, you can save a report in any file index.

1. On the toolbar click **Database**.
2. Select the report that is to be saved locally.
3. On the **File** menu click **Save report locally**.
4. Select the target directory where the report is to be saved.
5. Click **Save**.
**Report settings**

To open the report settings:

On the **Tools** menu, select **Settings**, and then click **Report**.

---

### Measurement system

Size and weight information can be given either in metric or imperial/US units.

### Show logo on report

Select the checkbox and then click **Select file**. From the Select logo dialog box, select a graphic file in bitmap (BMP) or JPEG format. The logo is scaled (85 pixels wide and 70 pixels high) and inserted at the top left of the report whenever a new report is created or an existing one is updated.

### Print several reports

Select the checkbox and specify the number of reports to be printed in the number field.

### Extended report

Select the Extended report checkbox to attach a graphic that summarizes events and presents the oximetry and pulse traces. The option is also available to display saturation measurements below 88% or below 89% by selecting the relevant boxes.

### Add prescription template

Clear the checkbox to remove the prescription form from the report. Otherwise the prescription is printed with the report when the AHI value is above 5.
Add referral template
In this template you can fill in information for the treating physician. You can choose to attach to each report or only if the AHI is above 5.

Show quick buttons in report view
Select the checkbox to display the Referral and Prescription buttons on the toolbar in the Report view. With these buttons you can attach the templates directly to the report.

Name of physician
You can enter the address of the physician to whom the patient is to be referred for further treatment manually in the text field. The program automatically saves addresses that are entered; these can be selected from the address list using the Select button.

Advanced settings
Use this option to determine whether the indicator graphic is calculated with (RI) or without (AHI) flow limitations. The indicator graphic can also be hidden.

1. Feature is only available in English versions of the ApneaLink software.
File transfer

Recordings
Each recording contains data (patient respiratory nasal airflow, snoring, blood oxygen saturation, pulse, respiratory effort and body position) that are stored as EDF+ files on the device. The recordings are accessible on your computer via USB connection and can be displayed in an EDF viewer. Patient respiratory nasal airflow, snoring, blood oxygen saturation, pulse and respiratory effort data can be analyzed with the ApneaLink software.

Archiving data
When data is archived, recordings are removed from the database to free space. Archived data remains visible in the database with the archiving date appended.

1. On the toolbar click **Archive**.

2. In the Records available panel, click the recording to be archived.

3. Click **>>** to move the selected recording into the Records to be archived panel.

   Alternatively, use **<<** to move recordings from the Records to be archived panel to the Records available panel.

4. Enter name in the Media name field.

   The media name appears in the recording information to identify the archive medium (eg, to archive a recording to an external hard disk, you can enter the designation “Hard Disk” in the “Media name” text field).

5. Click **Change target** to define the target directory for archiving. Select the archive directory and click **OK**.
Files are saved in the directory with automatically generated names. If no target directory is selected, the recording is archived in the default target directory.

6. Click **Archive**.
   The archived recording is marked in the Archived column of the database.

**Notes:**
- You can double-click a recording in the Records available panel to move automatically to the Records to be archived panel.
- It is not possible to write an archive file directly onto a CD within the ApneaLink program. The archive file has to be moved first into the target directory using the archiving function. You can then use CD or DVD writer software to write the file onto a CD or a DVD.

**Open archived recordings**
Double-click on the archived file in the database.
The archive recording opens in the signal view.
If the archive file is in a target directory that your computer can access, the archive file recording opens in the signal view without any further queries.

**Note:** If the archived file is on a CD, you must insert the required CD into your CD drive and select the archived file using a dialog box.

**Saving a copy of an archived recording**
No further editing can be carried out on archived recordings. You can however, save a copy of the archived recording in your database. To save a copy when the archived recording is displayed in the signal view, click **Save locally**. The associated report is also saved with a copy of the recording.

**View external data**
External recordings have the OSA filename extension. These files are not available in the database. You can use the “View external data” function to open recordings in the ApneaLink program that have been duplicated in copy form. This function can also be used to open archived data.

1. On the **File** menu select **View external data**.
2. Select a recording and click **Open**.
   The database displays the contents of the external OSA file.
You can open and examine the contents in this view. Additionally, the **Save locally** symbol appears in the toolbar. This function allows you to save a copy of an external recording in the database.

**Note:** OSA files that have been generated with an ApneaLink program older than Version 6.0 cannot be opened with the “View external data” function. These files must be opened using the “Import” function.
**Duplicate recording**

This function saves a copy of a recording in a defined target directory. The original recording remains unchanged in the database.

1. On the toolbar click **Database**.
2. Select one or more recordings.
3. On the **File** menu click **Duplicate**.
4. Select the directory and filename, then click **Save**.

**Exporting a recording as an EDF or EDF+ file**

You can export a recording as a European Data Format (EDF) or EDF+ file which are especially for measurement data exchange. Both formats can be displayed in EDF compatible software packages. With both formats the recording information is stored according to the export settings. Only the data display is different.

*Note: Before exporting a recording you should check the export settings in the Tools menu.*

1. Open the database.
2. Select the recording to be exported.
3. On the **File** menu select **Export**.
4. Click the required file format.
5. Select the target folder and click **Save**.

**Settings for EDF-Export**

1. In the **Tools** menu select **Settings**.
2. Click **EDF-Export**.
3. Select or clear checkboxes that apply to required channels and events.
4. Click **OK** to apply the required settings
   OR
   Click **Standard parameter** for the default settings.

**Note:** The settings apply to all recordings.

**Exporting a recording as CSV format**
You can export statistic data (e.g., AHI, HI) and text entries (e.g., patient data) of any recordings as a comma separated value (CSV) file. This file format allows the exchange of database tables between the ApneaLink program and other applications such as Microsoft Excel. In Excel, each recording is displayed as a dataset in one table row.

1. Open the Database.
2. From the **File** menu, select **Export**.
3. Select **CSV** from the list.
4. Select the target folder and click Save.

**Import recording**
OSA files generated using an ApneaLink program older than Version 6.0 can be viewed using the Import function.

1. From the **File** menu, select **Import recording**.
2. Select the recording and click **Open**.
   The database displays the contents of the external OSA file.

**Transferring the database**

1. From the **Tools** menu select **Database transfer**.
2. Click **Yes** to open the database transfer dialog box.

3. Click **Select database directory**.
4. Select the new database directory.
5. Click **OK** to confirm.
6. Click **Move database**.
7. Click **Exit** to close the dialog box.

The ApneaLink program restarts.

You can also open the database transfer dialog box in the Start menu. Select **Programs > ResMed > ApneaLink**.

**Notes:**
- The ApneaLink software can only process folder and file names according to ISO 8859-1 (Latin Western Europe) and ASCII. Unicode is not supported.
- After the database has been transferred into the new directory, a dialog box appears to confirm if you want to delete or retain the old database.

**Sending data by email**

ApneaLink Air uses the installed email client (Microsoft Outlook and Microsoft Outlook Express) to send reports or recordings by emails.

**Notes:**
- Recordings and reports contain patient data that must be treated as confidential under privacy legislation. Before sending such data by email, it is therefore necessary to obtain the patient’s consent.
- Before sending a recording or report with the ApneaLink program, check that Microsoft Outlook or Microsoft Outlook Express is set up to send emails.
- Depending on the length of the recording, an OSA file may be 5 MB or larger. Before sending the message, check that your email service is able to send this volume of data and that a message of this size will be accepted by the recipient’s email service.
- To prevent unauthorized or inadvertent disclosure of patients’ health information to third parties by the transmission via email, make sure the email is encrypted.

**Sending a report**

1. Open the database.
2. Select the report.
3. From the **File** menu, select **Send report by email**.

The email client opens. The report is attached to the email message as a PDF-file.

**Notes:**
- In order to open the report, the email recipient must have the Adobe Acrobat Reader installed.
- A report opened in Report view can also be sent by email.

**Sending a recording**

1. Open the database.
2. Select the recording.
3. From the **File** menu, select **Send recording by email**.
The email client opens. The recording is attached to the email message as an OSA file. Each OSA file also contains the patient details and the current report.

Notes:
- To be able to open the OSA file, the email recipient must have the ApneaLink program installed. The OSA file can be opened in the ApneaLink program using the View external data function or by double-clicking the file.
- ApneaLink programs older than Version 6.0 cannot display pulse oximetry data.
- ApneaLink programs older than Version 9.0 cannot display the effort channel.
Cleaning and maintenance

Regular cleaning and maintenance should be carried out on the ApneaLink Air system as described here. The cleaning shall be done by the physician or healthcare provider.

⚠️ CAUTION

- Never use abrasive agents, alcohol, chlorine-containing substances, acetone, or other solvents to clean the device.
- Do not immerse the device, pulse oximeter, oximeter finger sensor or respiratory effort sensor in fluids, and ensure that no fluids penetrate into the products.
- Do not attempt to sterilize the device, as this could cause unseen damage to the inside of the unit.

Cleaning

1. Switch off the device.
2. If still attached, remove and dispose of the nasal cannula.
3. Remove the respiratory effort sensor.
4. Screw the protective caps onto the connectors for the nasal cannula and effort sensor.
5. Detach the pulse oximeter from the device.
6. Detach the oximeter finger sensor from the pulse oximeter. **Note:** Handle the pulse oximeter connection carefully. Do not twist the oximeter cable.
7. Press the protective cover for the USB cable in the housing opening.
8. Clean the following parts with a damp cloth and a mild liquid soap: device and pulse oximeter housing, pulse oximeter cable, clip fastener and respiratory effort sensor.
9. Leave the cleaned parts to dry.
10. Dispose of the single-use oximeter finger sensor. If you are using other approved oximeter finger sensors, follow the manufacturer’s cleaning instructions.
11. Wash the belt by hand or in a regular washing machine at 86°F (30°C).
12. Allow the belt to drip dry. Do not tumble dry or dry clean.
Disinfection
The following disinfectants can be used on the ApneaLink Air device:
• Mikrozid
• Cavicide
• Clorox
• Lysol
After cleaning the ApneaLink Air system as instructed above, disinfect the ApneaLink Air device as follows:
1. Apply undiluted disinfectant to a clean non-dyed disposable cloth.
2. Wipe all surfaces of the device. Keep liquids away from any openings in the device.
3. Leave the disinfectant on the device for five minutes.
4. Wipe residual disinfectant from the device with a clean, dry, undyed disposable cloth.

Maintenance
• Replace the reusable belt every 100 uses.
• Replace the effort sensor every 200 uses.
• Replace the oximeter every 5 years.
• For replacement of the reusable oximeter finger sensor please read the manufacturer’s information supplied with the product.
All ApneaLink Air devices include automatic offset correction. An annual calibration service is not necessary.

Servicing
The ApneaLink Air system is intended to provide safe and reliable operation when operated in accordance with the instructions provided by ResMed. ResMed recommends that the ApneaLink Air system is inspected and serviced by an authorized ResMed Service Centre if there is any sign of wear or any concern with device function. Otherwise, service and inspection of the device should not be required during the five year design life of the device.

Note: There are no user serviceable parts. Do not attempt to open the device.
Troubleshooting

If any problems arise while using the device or the software, try the following solutions. If the problem cannot be solved, send the log file to the ApneaLink Air support team or contact your equipment supplier or ResMed. Do not attempt to open the device.

To send the log file, from the Tools menu select Send event log by email.

Device

<table>
<thead>
<tr>
<th>Problem/Possible cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>The power button light doesn’t turn on when the power button is pressed.</td>
<td>Replace the batteries by opening the battery cover and inserting two new batteries.</td>
</tr>
<tr>
<td>The batteries are depleted.</td>
<td>If the light does not turn on after replacing the batteries, return the device for servicing.</td>
</tr>
<tr>
<td>The device is faulty.</td>
<td></td>
</tr>
<tr>
<td>Oximeter LED is blinking red.</td>
<td>Connect the oximeter to the finger sensor.</td>
</tr>
<tr>
<td>The oximeter is not connected.</td>
<td></td>
</tr>
<tr>
<td>The oximeter is connected to the device, but the finger sensor is not connected to the oximeter.</td>
<td>Connect the finger sensor and oximeter.</td>
</tr>
<tr>
<td>The oximeter and finger sensor are connected, but there is no valid sensor signal for more than four seconds.</td>
<td>Check that the sensor is correctly placed on the finger and check the oximeter connection.</td>
</tr>
<tr>
<td>Flow LED is blinking red.</td>
<td></td>
</tr>
<tr>
<td>The nasal cannula is not correctly attached to the device.</td>
<td>Fit the nasal cannula as described in this manual.</td>
</tr>
<tr>
<td>Effort LED is blinking red.</td>
<td></td>
</tr>
<tr>
<td>The effort sensor is not correctly attached to the device.</td>
<td>Apply effort sensor as described in this manual.</td>
</tr>
<tr>
<td>All LEDs are blinking red during a recording.</td>
<td></td>
</tr>
<tr>
<td>The device is defective.</td>
<td>Return the device for servicing.</td>
</tr>
</tbody>
</table>
Program

<table>
<thead>
<tr>
<th>Problem/Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Program does not run, or generates error messages.</strong></td>
<td>Reinstall the ApneaLink program. If necessary, check your computer system for viruses.</td>
</tr>
<tr>
<td>The necessary program files are no longer available or are</td>
<td></td>
</tr>
<tr>
<td>Problem/Possible Cause</td>
<td>Solution</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>The device cannot be customized.</td>
<td>There are two or more devices simultaneously attached to the computer. Only connect one device to the computer at a time.</td>
</tr>
<tr>
<td>Data download between computer and device not possible.</td>
<td>Check that the USB cable connection between the device and the computer is correct, paying particular attention to the plug contacts.</td>
</tr>
<tr>
<td>Patient data is missing.</td>
<td>Enter the required personal details onto the patient record card (fields marked yellow).</td>
</tr>
<tr>
<td>The batteries are not present or are drained.</td>
<td>Replace battery/rechargeable battery.</td>
</tr>
<tr>
<td>USB connection between computer and device is incorrect.</td>
<td>Check that the USB cable connection between the device and the computer is correct, paying particular attention to the plug contacts.</td>
</tr>
<tr>
<td>USB cable is defective.</td>
<td>Contact ResMed or an authorized ResMed distributor to request a new USB cable.</td>
</tr>
<tr>
<td>Necessary program files are no longer available, or are corrupted.</td>
<td>Reinstall the ApneaLink program. If necessary, check your computer system for viruses.</td>
</tr>
<tr>
<td>Recording contains no data.</td>
<td>The device was not started. Start the recording. See “Starting the test” on page 13.</td>
</tr>
<tr>
<td>Report cannot be printed.</td>
<td>There is a problem with the printer. If necessary, consult your printer manual. Contact your computer service department.</td>
</tr>
<tr>
<td>An OSA file cannot be opened with the “View external data” function.</td>
<td>The OSA file was saved in a program version older than vers. 6.0. Save the OSA file in the database directly, using the import function in the file menu.</td>
</tr>
</tbody>
</table>
### Analysis

<table>
<thead>
<tr>
<th>Problem/Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Error message “... not a valid OSA file” appears when viewing or importing an external OSA file.</strong></td>
<td>Click on the OSA file in the Windows Explorer, right-click with the mouse, and rename the file.</td>
</tr>
<tr>
<td>The file name of the OSA file was assigned on a computer whose language setting uses a font that your computer cannot read.</td>
<td></td>
</tr>
<tr>
<td><strong>Transfer of report by email is not possible.</strong></td>
<td>Check the file size of the report logo in the report settings and decrease the resolution with a graphic program if the logo is oversized or reduce the configured screen resolution before capturing the screenshots. Re-analyze the recording to get a new report. Attach fewer screenshots to further reduce the file size.</td>
</tr>
<tr>
<td>The file size of the report is too large because of many screenshots or an oversized logo.</td>
<td></td>
</tr>
<tr>
<td>Your system restricts the data transfer by email.</td>
<td></td>
</tr>
<tr>
<td><strong>Error message “Not all archive files could be created.” appears during archiving</strong></td>
<td>Make sure an empty disk is inserted and you computer provides software for directly writing to CDs/DVDs.</td>
</tr>
<tr>
<td>Selected CD/DVD drive contains no media for data storage.</td>
<td></td>
</tr>
<tr>
<td>Selected media is write protected.</td>
<td>Make sure the used media is not write protected.</td>
</tr>
<tr>
<td>Selected media is full.</td>
<td>Make sure there is enough disk space for all recordings on the selected media.</td>
</tr>
</tbody>
</table>

**Problem/Possible Cause** | **Solution** |
---|---
**The program reports that no clock time was assigned to the beginning of the recording.** | **Signal too small.** |
| The batteries were removed after the device was customized. | Lay the cannula in a regular curve and fasten with adhesive tape. Check the status of the indicator light during recording. |
| The internal battery is defective. | **Contact ResMed or an authorized ResMed distributor.** |
| **There is a kink in the nasal cannula at the connection point.** | **The program reports that no clock time was assigned to the beginning of the recording.** |

**Problem/Possible Cause** | **Solution** |
---|---
**Error message “... not a valid OSA file” appears when viewing or importing an external OSA file.** | Click on the OSA file in the Windows Explorer, right-click with the mouse, and rename the file. |
| The file name of the OSA file was assigned on a computer whose language setting uses a font that your computer cannot read. | |
| **Transfer of report by email is not possible.** | Check the file size of the report logo in the report settings and decrease the resolution with a graphic program if the logo is oversized or reduce the configured screen resolution before capturing the screenshots. Re-analyze the recording to get a new report. Attach fewer screenshots to further reduce the file size. |
| The file size of the report is too large because of many screenshots or an oversized logo. | |
| Your system restricts the data transfer by email. | |
| **Error message “Not all archive files could be created.” appears during archiving** | Make sure an empty disk is inserted and you computer provides software for directly writing to CDs/DVDs. |
| Selected CD/DVD drive contains no media for data storage. | |
| Selected media is write protected. | Make sure the used media is not write protected. |
| Selected media is full. | Make sure there is enough disk space for all recordings on the selected media. |
### Troubleshooting

<table>
<thead>
<tr>
<th>Problem/Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>There is a blockage in the nasal cannula.</td>
<td>Exchange the nasal cannula.</td>
</tr>
<tr>
<td></td>
<td>Check the status of the indicator light during recording.</td>
</tr>
<tr>
<td>The sensor is defective.</td>
<td>Contact ResMed or an authorized ResMed distributor.</td>
</tr>
<tr>
<td>The nasal cannula or the oximeter finger sensor is not connected to the device correctly.</td>
<td>Check the nasal cannula and oximeter finger sensor connections.</td>
</tr>
<tr>
<td></td>
<td>Check the status of the indicator light during recording.</td>
</tr>
<tr>
<td>The nasal cannula has slipped.</td>
<td>Apply nasal cannula as described in the Patient Instructions.</td>
</tr>
<tr>
<td></td>
<td>Check the status of the indicator light during recording (also see above).</td>
</tr>
</tbody>
</table>

**The report indicates that the analysis time is too short.**

The analysis time is less than 60 minutes or the analysis time after manual editing is less than 60 minutes.

Edit the recording manually or make a new recording.

**It takes too long to open a report.**

The report includes many screenshots of the signal view or the file size or the inserted logo is oversized.

Check the file size of the report logo in the report settings and decrease the resolution with a graphic program if the logo is oversized. Re-analyze the recording to get a new report. Attach fewer screenshots to further reduce the file size.

**Analysis status shows: Hypopnea detection based on flow only.**

No oximetry information available at all, a significant portion of the oximetry channel was affected by artefacts, or usage of the AASM settings was switched off.

Carefully connect the oximeter (if available) to the device. Ensure that the oximeter sensor is attached properly to the patient’s finger. Check the analysis parameters.

**Only unclassified apneas.**

Effort sensor is not connected.

Check the effort sensor connection.

Effort sensor is defective.

Replace the effort sensor.
## Technical specifications

### System requirements

**Software**

The ApneaLink software is compatible with the following operating systems:
- Microsoft Windows XP
- Microsoft Windows Vista (32 bit and 64 bit versions)
- Microsoft Windows 7 (32 bit and 64 bit versions)
- Microsoft Windows 8 (32 bit and 64 bit versions)
- Adobe Reader version 8.0 and higher

*Note: Local administrator rights are required for installation.*

**Hardware**

For operation of the ApneaLink software the following minimum hardware configuration is required:
- Intel Core 2 processor or similar
- 512 MB RAM
- USB high speed port
- CD-ROM drive
- Screen resolution 800x600 pixel, high color (16 bit)

### Device, pulse oximeter and effort sensor

<table>
<thead>
<tr>
<th>Signal recording</th>
<th>Respiratory flow</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Respiratory effort</td>
</tr>
<tr>
<td></td>
<td>Blood oxygen saturation</td>
</tr>
<tr>
<td></td>
<td>Pulse</td>
</tr>
<tr>
<td></td>
<td>Body position</td>
</tr>
<tr>
<td></td>
<td>Battery voltage</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Sampling rates for the channels</th>
<th>Respiratory flow: 100 Hz</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Respiratory effort: 10 Hz</td>
</tr>
<tr>
<td></td>
<td>Blood oxygen saturation (SpO2): 1 Hz</td>
</tr>
<tr>
<td></td>
<td>Pulse: 1 Hz</td>
</tr>
<tr>
<td></td>
<td>Body position: 1 Hz</td>
</tr>
<tr>
<td></td>
<td>Battery: 1 Hz</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Recording time</th>
<th>4 x 12 hours</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power supply</td>
<td>Two NiMH rechargeable batteries (Micro/AAA/HR03/1.2 V/ min. 1000 mAh) or Two batteries (Micro/AAA/LR03/1.5 V/min. 1000 mAh).</td>
</tr>
<tr>
<td>Weight</td>
<td>Recorder: Approx. 2.4 oz (66 g) without rechargeable batteries or batteries</td>
</tr>
<tr>
<td></td>
<td>Pulse Oximeter: approx. 1.1 oz (30 g)</td>
</tr>
</tbody>
</table>
Environmental conditions
Operating temperature: 41°F to 104°F (5°C to 40°C)
Operating humidity: 10% to 90% non-condensing
Storage and transport temperature: -13°F to 158°F (-25°C to 70°C)
Storage and transport humidity: 10% to 95% non-condensing
Operating air pressure: 700 hPa to 1,060 hPa

Displayed range
Pressurer sensor (nasal cannula): -6 hPa to +6 hPa
Pressure sensor (respiratory effort): -6 hPa to +6 hPa
SpO₂: 0% to 100%
Pulse: 18 to 321 bpm

Body position measurement

Definition of position values:
0 - prone
1 - prone right
2 - right
3 - supine right
4 - supine
5 - supine left
6 - left
7 - prone left
8 - upright medium
9 - upright high
Accuracy (no movement) SpO₂ (Range: 70% to 100%):
+/- 2 digits for use with oximeter finger sensor 8000AA, 8000SM
+/- 3 digits for use with oximeter finger sensor 7000A
Pulse (Range: 18 to 300 bpm):
+/- 3 digits for use with all specified oximeter finger sensors

Accuracy (movement) SpO₂ (Range: 70% to 100%):
+/- 3 digits for use with oximeter finger sensor 8000AA, 8000SM and 7000A
For further accuracy and clinical validation testing information please refer to the finger sensor instructions.

Body position: +/- 12.5°

Interfaces
Nasal cannula: Female Luer connection
Pulse oximeter: 3-pin Binder plug
USB connection: Highspeed USB 2.0
Respiratory effort: Male Luer connection

Dimension
Recorder: (length x width x height) 2.4” x 4” x 1.2”
(62 x 102 x 30 mm)
Pulse oximeter: (length x width x height) 2.1” x 0.8” x 0.6”
(53 x 20 x 15 mm)

Electromagnetic compatibility
The ApneaLink Air complies with all applicable electromagnetic compatibility requirements (EMC) according to IEC60601-1-2, for residential, commercial, and light industry environments.
Wireless communications equipment such as wireless home network device, mobile phones, cordless telephones and their base stations, walkie-talkies can affect the device and should be kept at least a distance d away from the device. As example the distance d for a typical mobile phone with a maximum output power of 2 W would be 10’ 8” (3.3 m).
For further details, see “Electromagnetic Emissions and Immunity” on www.resmed.com on the Products page under Service & Support. If you do not have internet access, please contact your ResMed representative.

1. Device without rechargeable batteries or normal batteries.
Technical specifications

Symbols

- Manufacturer
- Follow instructions for use
- CE labelling in accordance with EC directive 93/42/EEC, class II a
- Type BF applied part (this includes the device and accessories).
- IP 22 Device is protected against ingress of solid foreign objects of 12.5 mm diameter or greater and against ingress of dripping water (15° tilted) with harmful effects.
- Serial number
- Catalog number
- Batch code
- Start/Stop recording
- USB connection
- Fragile – handle with care
- Keep dry
- Temperature limitation (storage and transport)
- U.S. Federal law restricts this device for sale by or on the order of a physician.
- This way up
- Do not re-use
- Not made with natural rubber latex
- Atmospheric pressure limitation
- MR unsafe (do not use in the vicinity of an MRI device).
Disposal

Disposal of an end-of-life device, the finger pulse sensors, the pulse oximeter, the effort sensor and the packaging must be carried out in accordance with applicable national laws and regulations.

The crossed-out wheeled bin symbol indicates that the product bearing this symbol may not be disposed of together with general household waste, but instead requires separate disposal. This requirement for separate disposal is based on the European Directive 2012/19/EU for electrical and electronic equipment, and the European Directive 2006/66/EC for batteries. You can hand in the product at a municipal collection point, for example. This reduces the impact on natural resources and prevents contamination of the environment through the release of hazardous substances.

Batteries containing more than 0.0005 percent of mercury by mass, more than 0.002 percent of cadmium by mass or more than 0.004 percent of lead by mass are marked below the crossed-bin symbol with the chemical symbols (Hg, Cd, Pb) of the metals for which the limit is exceeded.

For information on the easiest way to dispose of your ApneaLink Air system, or for further details, please contact your ResMed office, your local distributor, or visit the website: www.resmed.com.

Dispose of the nasal pressure cannula in ordinary household waste.
Disposal of the batteries and the rechargeable batteries must be carried out with the national regulations and statutory provisions applicable.
Limited warranty

ResMed Germany Inc. (hereafter ‘ResMed’) warrants that your ResMed product shall be free from defects in material and workmanship from the date of purchase for the period specified below.

<table>
<thead>
<tr>
<th>Product</th>
<th>Warranty Period</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Mask systems (including mask frame, cushion, headgear and tubing)—excluding single-use devices</td>
<td>90 days</td>
</tr>
<tr>
<td>• Accessories—excluding single-use devices</td>
<td></td>
</tr>
<tr>
<td>• Flex-type oximeter finger pulse sensors</td>
<td></td>
</tr>
<tr>
<td>• Humidifier water tubs</td>
<td></td>
</tr>
<tr>
<td>• Batteries for use in ResMed internal and external battery systems</td>
<td>6 months</td>
</tr>
<tr>
<td>• Clip-type finge pulse sensors</td>
<td>1 year</td>
</tr>
<tr>
<td>• CPAP and bilevel device data modules</td>
<td></td>
</tr>
<tr>
<td>• Oximeters and CPAP and bilevel device oximeter adapters</td>
<td></td>
</tr>
<tr>
<td>• Humidifier cleanable water tubs</td>
<td></td>
</tr>
<tr>
<td>• Titration control devices</td>
<td></td>
</tr>
<tr>
<td>• CPAP, bilevel and ventilation devices (including external power supply units)</td>
<td>2 years</td>
</tr>
<tr>
<td>• Humidifiers</td>
<td></td>
</tr>
<tr>
<td>• Battery accessories</td>
<td></td>
</tr>
<tr>
<td>• Portable diagnostic/screening devices</td>
<td></td>
</tr>
</tbody>
</table>

This warranty is only available to the initial consumer. It is not transferable.

If the product fails under conditions of normal use, ResMed will repair or replace, at its option, the defective product or any of its components.

This Limited Warranty does not cover: a) any damage caused as a result of improper use, abuse, modification or alteration of the product; b) repairs carried out by any service organization that has not been expressly authorized by ResMed to perform such repairs; c) any damage or contamination due to cigarette, pipe, cigar or other smoke; and d) any damage caused by water being spilled on or into an electronic device.

Warranty is void on product sold, or resold, outside the region of original purchase.

Warranty claims on defective product must be made by the initial consumer at the point of purchase.

This warranty replaces all other expressed or implied warranties, including any implied warranty of merchantability or fitness for a particular purpose. Some regions or states do not allow limitations on how long an implied warranty lasts, so the above limitation may not apply to you.
ResMed shall not be responsible for any incidental or consequential damages claimed to have resulted from the sale, installation or use of any ResMed product. Some regions or states do not allow the exclusion or limitation of incidental or consequential damages, so the above limitation may not apply to you.

This warranty gives you specific legal rights, and you may also have other rights which vary from region to region. For further information on your warranty rights, contact your local ResMed dealer or ResMed office.